SMART Learning Suite 17

SYSTEM ADMINISTRATOR’S GUIDE
FOR WINDOWS OPERATING SYSTEMS
Trademark notice
SMART Notebook, SMART Ink, SMART Document Camera, smarttech, the SMART logo and all SMART taglines are trademarks or registered trademarks of SMART Technologies ULC in the U.S. and/or other countries. Microsoft, Windows, Internet Explorer, ActiveX, DirectX and Visual Studio are either registered trademarks or trademarks of Microsoft Corporation in the U.S. and/or other countries. Adobe Reader is either registered a trademark or trademark of Adobe Systems Incorporated in the U.S. and/or other countries. Firefox is a registered trademark of the Mozilla Foundation. InstallShield is a registered trademark or trademark of Flexera Software, Inc. and/or InstallShield Co. Inc. in the United States of America and/or other countries. All other third-party product and company names may be trademarks of their respective owners.

Copyright notice
© 2017 SMART Technologies ULC All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into any language in any form by any means without the prior written consent of SMART Technologies ULC. Information in this manual is subject to change without notice and does not represent a commitment on the part of SMART.

This product and/or use thereof covered by one or more of the following U.S. patents.
www.smarttech.com/patents
06/2017

smarttech.com/kb/171152
Contents

Chapter 1: Getting started ................................................................. 1
  Computer requirements ............................................................ 2
  Locating installation and supporting files .................................. 3
  Activation connectivity ............................................................. 6

Chapter 2: Customizing the software ............................................ 9
  Using SMART Install Manager .................................................. 9
  Using third-party tools ............................................................ 15

Chapter 3: Deploying the software .................................................. 25
  Using the command-line interface ............................................ 26
  Using third-party imaging or remote management software .......... 29

Chapter 4: Activating and renewing the software ......................... 31
  Activating the software during installation ............................... 31
  Activating the software after installation .................................. 32
  Renewing keys ....................................................................... 34
  Using SMART Product Update (SPU) to retrieve activation status . 38
  Returning a product key activation with a command-line script .... 39

Chapter 5: Updating the software ................................................... 41
  Using a Windows Installer update installation package (MSI file) ....... 42
  Using a Windows Installer patch (MSP file) ............................... 43

Chapter 6: Uninstalling the software ............................................... 45
  Using the SMART Uninstaller user interface ............................... 45
  Using the SMART Uninstaller command line interface .............. 46

Appendix A: Language files and codes ......................................... 53
  Installation language files and codes ....................................... 53
  Handwriting recognition resources ......................................... 54

Installing and maintaining Gallery content ................................ 57
  Configuring Gallery content using SMART Install Manager .......... 57
  Working with Gallery content locations ................................... 58
Chapter 1

Getting started

Computer requirements .................................................................................................................. 2
Locating installation and supporting files .................................................................................. 3
  Locating the complete installer ............................................................................................... 3
  Locating installation packages ................................................................................................. 4
  Required third-party packages .................................................................................................. 5
  Language files .......................................................................................................................... 5
Activation connectivity ................................................................................................................. 6
  Using SMART Install Manager ................................................................................................. 6
  Using Activation Wizard .......................................................................................................... 6

This guide explains how to customize and deploy the following software:

- SMART Notebook 17 collaborative learning software
- SMART Notebook Math Tools software
- SMART Product Drivers 12.8
- SMART Ink® 5.1

NOTE

For information on customizing and deploying previous versions of this software, see the appropriate system administrator’s guides, available from smarttech.com/support.

This guide is intended for IT administrators and others experienced with customizing, deploying and administering Windows® software in a networked environment. To use this guide, you must

- Know IT terminology such as “registry” and “domain controller”
- Know how to complete basic administrative tasks in Windows operating systems such as modifying the registry
- Have administrative privileges and access to servers
- Have access to the Internet
**IMPORTANT**

You must run the commands documented in this guide in an *Administrator Command Prompt* window. To open an *Administrator Command Prompt* window, right-click the *Command Prompt* icon, and then select *Run as Administrator*.

---

**Computer requirements**

**NOTE**

Operating systems and other third-party software released after this SMART software might not be supported.

Before you install the software, ensure your teachers’ computers meet the minimum requirements:

<table>
<thead>
<tr>
<th>Supported operating systems</th>
<th>Windows 10</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows 8.1</td>
</tr>
<tr>
<td></td>
<td>Windows 7 SP1 (with Platform Update KB2670838 and one of the following security update KB3033929, or any future update that supersedes these).</td>
</tr>
<tr>
<td>Minimum processor</td>
<td>Intel® Core™ 2 Duo</td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>2 GB (4 GB for UHD displays)</td>
</tr>
<tr>
<td>Minimum hard disk space</td>
<td>4.7 GB</td>
</tr>
<tr>
<td>Other requirements</td>
<td>Microsoft® .NET Framework 4.5.1 for SMART Notebook software and SMART Ink</td>
</tr>
<tr>
<td></td>
<td>Microsoft Visual Studio® Tools 2010 for Office for SMART Ink</td>
</tr>
<tr>
<td></td>
<td>Adobe Reader® 8.0 or later</td>
</tr>
<tr>
<td></td>
<td>DirectX® technology 10 or later for SMART Notebook software</td>
</tr>
<tr>
<td></td>
<td>DirectX 10 compatible graphics hardware for SMART Notebook software</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer® Internet browser 8 or later</td>
</tr>
<tr>
<td></td>
<td>Internet access to download SMART software</td>
</tr>
</tbody>
</table>

**IMPORTANT**

- Some features require access to specific web sites. You might need to white list those web sites if your network restricts outbound Internet access.
For a complete list of websites to white list see SMART knowledge base article SMART Notebook add-ons behave unexpectedly behind a firewall or proxy.

All prerequisite third-party software is built into the EXE file and is automatically installed in the correct order if you deploy the EXE file.

The required Microsoft .NET Framework and Microsoft Visual Studio Tools 2010 for Office prerequisites will be installed automatically when you run the EXE file.

Locating installation and supporting files
Before you can customize or deploy SMART software, you must decide which type of file to use for the installation, and then locate the installation and supporting files. Select one of the following available installation file types.

- Complete installer, also known as an executable (EXE) file
- Installation package, also known as an MSI file

Locating the complete installer
You can download a version of the complete installer (EXE Installer - smart17-0admin.exe) from https://education.smarttech.com/en/products/notebook/download#admin.

To download the third-party installation package

2. Select SMART Notebook 17.0 from Select your version.
3. Select Admin Msi installer package from Select install package.
4. Enter your information in the following fields:
   a. First Name
   b. Last Name
   c. Job Title
   d. Email
   e. Country
5. Select the service agreement check box.
6. Select Windows from Change operating system.
7. Click DOWNLOAD - WINDOWS.
8. Browse to and double click the file you downloaded.


   When the third-party installation packages are unzipped, they can be found in the root of the Support folder.

---

**NOTE**

If you do not have a license key select Download a trial version today the trial version is only available for EXE.

---

**Locating installation packages**

The SMART Learning Suite installation package (SMARTLearningSuite.msi), supporting third-party installers, and supporting handwriting language packages can be found within the .zip file and you can download the installation packages from https://education.smarttech.com/en/products/notebook/download#admin.

Extract and save the installation packages in a location on your network that’s accessible to all computers on which you plan to install the software.

---

**IMPORTANT**

SMART recommends that you use the SMARTLearningSuite.msi installation package to deploy the SMART software. If you deploy the software using individual installation packages, you need to do the following:

- Ensure you use one path for the INSTALLDIR property for SMART Product Drivers and SMART Ink, and use a second path for the INSTALLDIR property for SMART Notebook software.

- If you deploy any handwriting recognition resource with the administrator installer, ensure the Support\Language folder exists in the root of the admin.zip and the folder structure is intact if you install handwriting languages. This allows the administrator installer to find the resources to install.
**Required third-party packages**
Before deploying the SMART Learning Suite installation package, you must deploy the following third-party installation packages:

<table>
<thead>
<tr>
<th>If you want to install this software:</th>
<th>Deploy these installation packages:</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART Notebook software</td>
<td>• Microsoft .NET Framework 4.5.1 files (dotNetFx451_Full_setup.exe)</td>
</tr>
<tr>
<td>SMART Ink</td>
<td>• Microsoft .NET Framework 4.5.1 files (dotNetFx451_Full_setup.exe)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Visual Studio Tools for Office (vstor_redist.exe for both 32-bit and 64-bit computers)</td>
</tr>
</tbody>
</table>

**IMPORTANT**

- Install all the prerequisite third-party installation packages before you deploy the **SMARTLearningSuite.msi** package. Some SMART Notebook software features will not function as expected if the prerequisite third-party software is not installed first. For more information, see **Installing prerequisite third-party software** on page 26.

- You can run the **dotNetFx451_Full_setup.exe** file to install all required Microsoft .NET Framework prerequisites and the Microsoft .NET Framework 4 Client Profile files. However, SMART recommends that you download the latest version of the Microsoft .NET Framework files from the Microsoft website. For information on deploying the Microsoft .NET Framework, refer to the **.NET Framework deployment guide for administrators** on the MSDN website (msdn.microsoft.com/en-us/library/ee390831.aspx).

  Internet connection is required to download and install the full .NET package.

**Language files**

If you plan to deploy the installation packages in a language other than English (U.S.), ensure the corresponding MST file for the language is in the same folder as the MSI file (see **Installation language files and codes** on page 53).

Similarly, if you want users to be able to view and use the handwriting recognition feature in a language other than English, you must download and install the appropriate handwriting recognition resources (see **Handwriting recognition resources** on page 54).
NOTE
For users running from the EXE file, the handwriting recognition feature will automatically download and install the selected languages.

Activation connectivity
When you deploy SMART Notebook software, make sure the computers can access SMART’s web activation services. Otherwise, the computers will not be able to activate product keys, during or after installation.

The activation web services are accessible at the following URLs:

- https://activationservice.smarttech.com/IntegrationCore?WSDL
- https://activationservice.smarttech.com/flexnet/services/ActivationService?WSDL
- https://entitlement.smarttech-prod.com/reachability

When viewed in a web browser, each of the above URLs should display a WSDL document. The last URL should display a XML document: <?xml version="1.0"?><reachable/>.

NOTE
If these sites are blocked by a proxy in your organization, add the URLs to the proxies.

SMART Install Manager and Activation Wizard will test these URLs and indicate success or failure. When you use the SMART Install Manager tool, consider that you, as an administrator, may have less restricted access to the Internet than standard users. It is important to install SMART Notebook software on a standard user’s computer and use the Activation Wizard connectivity tester to confirm connectivity.

Using SMART Install Manager
Start the connectivity tester by pressing the Check Activation Server button. The tester will appear and show green check marks to indicate success. SMART Install Manager will also prompt you to use the connectivity tester at the time of publishing customizations.

Using Activation Wizard
In the Activation Wizard you can access the connectivity tester from the Advanced drop-down menu in the lower left of the Activation Wizard. The tester will appear and show green check marks
to indicate success.

See the Activation FAQ for more details and for information about other issues related (Installing and Maintaining SMART Notebook 17).
Chapter 2
Customizing the software

Using SMART Install Manager ................................................................. 9
Selecting an installation file ................................................................. 10
Using SMART Install Manager with the complete installer ..................... 11
Using SMART Install Manager with the installation packages .................. 11
SMART Install Manager controls ......................................................... 12
Using third-party tools ........................................................................ 15
Windows Installer properties ............................................................... 16

You can use SMART Install Manager to customize the software. SMART Install Manager works with the complete installer (EXE file) or the installation package (MSI file).

If you’re using the installation package, you can alternatively customize the software using third-party tools and Windows Installer properties.

Using SMART Install Manager
Using SMART Install Manager, you can customize SMART software complete installers by publishing XML files. You can also customize SMART software installation packages by publishing MST files. You can then deploy the SMART software to computers.

To download and install SMART Install Manager
1. Go to smarttech.com/administratordownloads.
2. Select SMART Notebook 17.0 from Select your version.
3. Select SMART Install Manager from Select install package.
CHAPTER 2
CUSTOMIZING THE SOFTWARE

4. Enter your information in the following fields:
   a. First Name
   b. Last Name
   c. Job Title
   d. Email
   e. Country

5. Select the service agreement check box.
6. Select Windows from Change operating system.
7. Click DOWNLOAD - WINDOWS
8. Save the EXE file to your computer.
   The SMART Install Manager installation wizard appears.
10. Follow the on-screen instructions.

To customize SMART Learning Suite 17 using SMART Install Manager
1. Start SMART Install Manager.
2. Drag the complete installer or the installation package to the SMART Install Manager window.
3. Set the controls on each page (see SMART Install Manager controls on page 12).
4. Select File > Publish.
   The Save file dialog box appears.
5. Browse to the location where you extracted the complete installer or the installation package.
6. Type a name for the XML file (for the complete installer) or MST file (for the installation package) in the File name box, and then press Save.
7. Close SMART Install Manager.

Selecting an installation file
After you install SMART Install Manager, shortcuts to the software appear on the desktop and in the Start menu (Windows 7 or 10 operating systems) or the Apps screen (Windows 8 operating system).
You can use SMART Install Manager with either the complete installer or with the installation packages. Depending on which file type you select, you can do the following:

<table>
<thead>
<tr>
<th>Installation file</th>
<th>Tasks</th>
</tr>
</thead>
</table>
| Complete installer (.exe file) | - Open and customize the complete installer (.exe file).  
                                     - Save your changes to the installation package as an XML file.  
                                     - Publish your changes to the installation packages as an XML file. |
| Installation package (.msi file) | - Open and customize an installation package (.msi file).  
                                        - Save your changes to the installation package as an XML file.  
                                        - Publish your changes to the installation packages as an MST file. |

Using SMART Install Manager with the complete installer

Use the following instructions if you selected the complete installer.

**Opening a complete installer file**

To customize the complete installer, drag the file into the SMART Install Manager window.

After you open the complete installer, a set of pages for that installer appears in SMART Install Manager. Customize the complete installer using the controls on these pages.

**Saving your changes**

After you customize the complete installer, save your changes as an XML file by selecting File > Save As. When you next start SMART Install Manager, load the XML file by selecting File > Open, or by opening the EXE file and then selecting File > Import.

**Publishing your changes as an XML file**

The final step in using SMART Install Manager to customize the complete installer is to publish your changes as an XML file. To do this, select File > Publish, and then use the dialog box to define a location for and create the XML file.

Using SMART Install Manager with the installation packages

Use the following instructions if you selected the installation packages.
Opening a complete installer file

To customize an installation package, drag the file into the SMART Install Manager window.

NOTE

All installation packages you've previously opened in SMART Install Manager appear in the Unmodified Packages tab.

After you open an installation package, a set of pages for that installation package appears in SMART Install Manager. Customize the installation package using the controls on these pages.

Saving your changes

After you customize an installation package, save your changes as an XML file by selecting File > Save As. When you next start SMART Install Manager, load the XML file by selecting File > Open, or by opening the MSI file and then selecting File > Import.

Publishing your changes as an XML file

The final step in using SMART Install Manager to customize an installation package is to publish your changes as an MST file. To do this, select File > Publish, and then use the dialog box to define a location for and create the MST file.

TIP

If you use an older MST file created with an earlier version of the MSI file, it might not work properly. Use the current MSI file to create your MST file. Publish the MST file in the same location as the MSI file.

SMART Install Manager controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Procedure</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Options: Product Selection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SMART Product Drivers</td>
<td>Select to install SMART Product Drivers.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>SMART Ink</td>
<td>Select to install SMART Ink.</td>
<td>If you install SMART Ink, you must install SMART Product Drivers. When you select this check box, SMART Install Manager selects SMART Product Drivers automatically.</td>
</tr>
<tr>
<td>SMART Notebook software</td>
<td>Select to install SMART Notebook software.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>Product key</td>
<td>Type your 25-character product key for SMART Notebook software.</td>
<td>You can type the product key with or without hyphens. When you type a volume product key, the software activates when you deploy it to your network computers.</td>
</tr>
</tbody>
</table>
## CHAPTER 2
CUSTOMIZING THE SOFTWARE

<table>
<thead>
<tr>
<th>Control</th>
<th>Procedure</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART Notebook Math Tools</td>
<td>Select to install SMART Notebook Math Tool software.</td>
<td>If you choose to install SMART Notebook Math Tools software, you must also install SMART Notebook software.</td>
</tr>
<tr>
<td>Product key</td>
<td>Type you 22- or 25-character product key for SMART Notebook Math Tools software.</td>
<td>You can type the product key with or without hyphens. When you type a volume product key, the software activates when you deploy it to your network computers.</td>
</tr>
<tr>
<td>Remove SMART products that aren’t selected above if they exist on the system</td>
<td>Select to remove SMART software products available in the current SMART Learning Suite package found on any machine on your system (except the SMART products you selected above). If you don’t select this setting, all SMART Learning Suite software found is upgraded, even if the SMART software isn’t selected above.</td>
<td>This affects the behavior of the installer when you perform an upgrade. It enables you to remove any software in the current SMART Learning Suite package that isn’t selected in the SMART Install Manager.</td>
</tr>
<tr>
<td>Delay activation</td>
<td>Select to register the product keys on a system without activating them. Registered keys can be activated when users start SMART Notebook software. If you don’t select this setting, the software automatically activates during installation rather than manually after installation.</td>
<td>Delaying activation is useful for uniform deployments that include users who don’t use SMART Notebook software. Only users who start SMART Notebook software activate registered keys and consume a license.</td>
</tr>
<tr>
<td>Disable the License Status dialog box</td>
<td>Select to prevent the software activation reminder from appearing after SMART Notebook software starts.</td>
<td>When this check box is selected, the software activation reminder appears only when the SMART Notebook software trial period expires.</td>
</tr>
</tbody>
</table>

### General Options: Installation Options

| Installation directory | Type the path to your preferred folder where program installation files are stored. Once you specify the path, selected programs are installed in sub-directories of this location. | If you specify a folder, include a back slash (\) at the end of the path. If you don’t specify a folder, Windows Installer installs the software in sub-directories of the default folder C:\Program Files\SMART Technologies (32-bit systems) or C:\Program Files (x86) SMART Technologies (64-bit systems). IMPORTANT Ensure the folder path valid. SMART Installer Manager doesn’t verify the folder path. |
| Start SMART System Menu at logon | Select to start the SMART System Menu when the user logs on. | [N/A] |
# CHAPTER 2
CUSTOMIZING THE SOFTWARE

<table>
<thead>
<tr>
<th>Control</th>
<th>Procedure</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART Technologies Error Report</td>
<td>SMART Technologies Error Report installs by default as part of the installation.</td>
<td>This application installs by default as part of the installation, but can be turned off through Install Manager.</td>
</tr>
<tr>
<td>Install desktop shortcuts</td>
<td>Select to create shortcuts on the desktop.</td>
<td>In the Windows 7 operating system, this option creates shortcuts on the desktop. In the Windows 8.1 operating system, shortcuts are created in the Windows 8.1 Apps menu.</td>
</tr>
</tbody>
</table>

**General Options: Network/Firewall Settings**

| SMART lab features operates as expected      | Add the URLs to your teacher and student network's whitelist.            | This setting confirms that the SMART lab features operate correctly in SMART Notebook.                                             |

**Handwriting recognition: Language selection**

| General Options: Language Selection          | Select the handwriting recognition resources you want to install.        | Don't select more than 18 handwriting recognition resources if you're running an administrator installation with the SMARTLearningSuite.msi file (see smarttech.com/kb/170081). |

**General Options: SMART Product Update**

| Install SMART Product Update in Full mode    | Select to install SMART Product Update (SPU) in Full mode.               | [N/A]                                                                                                                                 |
| Install SMART Product Update in Dashboard mode| Select to install SPU in Dashboard mode.                                  | [N/A]                                                                                                                                 |
| Do not install SMART Product Update          | Select to not install SPU.                                               | [N/A]                                                                                                                                 |
| Check for updates                           | Type the number of days (1 to 60) between SPU checks.                    | This option is available only if you install SPU in Full mode. By default, SPU checks for product updates every 30 days.          |
| Notify users about SMART product updates     | Select to notify users of available SMART product updates.               | This option is available only if you install SPU in Full mode.                                                                    |
| Reset per-user changes to the previous two settings | Select to remove existing **Check for updates** and **Notify users about SMART product updates** values the next time the user runs SPU. | This enables administrators to push new values for these settings to computers and ensures the new values are accepted. Individual users can still modify these settings. |

**General Options: Customer Experience**

| Enable the Customer Experience Program on all devices | Select to automatically enable the Customer Experience Program for all users. | [N/A]                                                                                                                                 |
| Disable the Customer Experience Program on all devices | Select to automatically disable the Customer Experience Program for all users. | [N/A]                                                                                                                                 |
## Using third-party tools

You can customize SMART software installation packages by creating MST files using a third-party tool, such as Orca database editor, and the Windows Installer properties (see *Windows Installer properties* on the next page).
## Windows Installer properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Allowed values</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General properties</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TRANSFORMS</td>
<td>[String]: A language MST file for the installation (see Installation language files and codes on page 53).</td>
<td>Ensure the specified MST file is in the same folder as the MSI file. This property defines the language of the installer’s user interface and the installed software’s icons and shortcuts. It doesn’t define the installed software’s user interface language. The installed software uses the computer’s operating system language if it’s supported, or English (U.S.) if not. You can also use the TRANSFORMS property to apply an MST file created by SMART Install Manager or a third-party tool.</td>
</tr>
</tbody>
</table>
| MSIFASTINSTALL | 1: Disable creating a system restore point.  
0 (default): Ask Windows to create a system restore point. | This property applies to the complete installer (EXE) only. The MSI installer follows Windows Installer conventions and doesn’t create a system restore point in quiet (/qn) mode, but asks Windows to create a system restore point in full, reduced or basic UI modes. By default, Windows 8.1 operating system and later creates a maximum of one system restore point in a 24-hour period. |
| ACTIVATE_LICENSE | 1 (default): Register the product keys and automatically activate the software.  
0: Register the product keys and don’t automatically activate the software (delay activation). Registered keys can be activated when users start SMART Notebook software. | Delaying activation (0) is useful for uniform deployments that include users who don’t use SMART Notebook software. Only users who start SMART Notebook software activate registered keys and consume a license. |
<table>
<thead>
<tr>
<th>Property</th>
<th>Allowed values</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISABLE_NAG</td>
<td>1: Prevent the software activation reminder from appearing after SMART Notebook software starts. 0 (default): Allow the software activation reminder to appear after SMART Notebook software starts.</td>
<td>When 1 is selected, the software activation reminder appears only when the SMART Notebook software trial period expires.</td>
</tr>
<tr>
<td>INSTALL_BOARD</td>
<td>1: Install SMART Product Drivers. [Empty string]: The product is turned off.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>LAUNCH_SYSTEM_MENU</td>
<td>1 (default): Automatically start SMART System Menu after installation and each time the system is started. [Empty string]: Don’t automatically start SMART System Menu after installation and each time the system is started.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>INSTALL_INK</td>
<td>1: Install SMART Ink [Empty string]: The product is turned off.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>INSTALL_NOTEBOOK</td>
<td>1: Install SMART Notebook software. [Empty string]: The product is turned off.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>NB_PROD_KEY</td>
<td>[String]: The 25-character product key for SMART Notebook software you received from SMART.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>MATH_PROD_KEY</td>
<td>[String]: The 22- or 25-character product key for SMART Notebook Math Tools software you received from SMART.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>UNINSTALLEXISTING</td>
<td>1: Remove SMART software products available in the current SMART Learning Suite package found on any machine on your system (except any SMART products you included in your command). [Empty string] (default): Upgrade all SMART Learning Suite software found on your system, even if the SMART software isn't selected above.</td>
<td>This enables you to remove any software in the current package that isn't included in your command.</td>
</tr>
<tr>
<td>Property</td>
<td>Allowed values</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>INSTALLDIR</td>
<td>[String]: Type the path to your preferred folder where program installation files are stored. Once you specify the path, selected programs are installed in sub-directories of this location</td>
<td>[N/A]</td>
</tr>
<tr>
<td>DESKTOP_ICONS</td>
<td>1 (default): Creates desktop shortcuts to the software. [Empty string]: Does not create desktop shortcuts.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>CR_ENABLED</td>
<td>1 (default): Enables SMART Technologies Error Report. 0: Disables SMART Technologies Error Report.</td>
<td>[N/A]</td>
</tr>
<tr>
<td><strong>SPU properties</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INSTALL_SPU</td>
<td>1 (default): Install SPU in Full mode. 2: Install SPU in Dashboard mode. 0: Don’t install SPU.</td>
<td>In Full mode, users can view the installed versions of SMART software as well as their product keys, and download and install updates.</td>
</tr>
<tr>
<td>SPU_TIME_FRAME</td>
<td>[Integer]: The time in days (1 to 60) between SPU checks.</td>
<td>By default, SPU checks for product updates every 30 days. This property is applicable only if you install SPU.</td>
</tr>
<tr>
<td>PRODUCT_NOTIFICATION</td>
<td>1 (default): Notify the user when updates are available from SPU. 0: Don’t notify the user when updates are available from SPU.</td>
<td>This property is applicable only if you install SPU.</td>
</tr>
<tr>
<td>INVALIDATE_HKCU_INTERVAL</td>
<td>1: Remove existing Check for updates and Notify users about SMART product updates values the next time the user runs SPU. 0 (default): Don’t remove existing Check for updates and Notify users about SMART product updates values the next time the user runs SPU.</td>
<td>This enables administrators to push new values for these settings to computers and ensures the new values are accepted. Individual users can still modify these settings</td>
</tr>
</tbody>
</table>
### CHAPTER 2
CUSTOMIZING THE SOFTWARE

<table>
<thead>
<tr>
<th>Property</th>
<th>Allowed values</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Customer Experience Program properties</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTOMER_LOGGING</td>
<td>1 (default): Enable the Customer Experience Program. 0: Disable the Customer Experience Program.</td>
<td>[N/A]</td>
</tr>
<tr>
<td><strong>SMART Notebook software properties</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FULL_GALLERY</td>
<td>1: Install the full product. [Empty string]: The product is turned off.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>LATCONTENT</td>
<td>1: Install the Lesson Activity Toolkit collection. [Empty string]: The product is turned off.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>TEAMCONTENTPATH</td>
<td>[String]: Specify the path to the Team Content folder, which is a location on your school’s network where users can store shared content.</td>
<td>You must specify a path to an existing folder in this property.</td>
</tr>
<tr>
<td>MYCONTENT</td>
<td>[String]: Specify the path to the My Content folder, which is a location on the user’s computer where he or she can store individual content.</td>
<td>You can include environment variables in the path. This property is useful if you want to store content in a shared network folder so users can access their My Content folder from any computer on the network.</td>
</tr>
<tr>
<td>PRINT_CAPTURE</td>
<td>1 (default): Install the Print Capture Driver. [Empty string]: Don’t install the Print Capture Driver.</td>
<td>The Print Capture Driver is a printer driver that enables users to export content from other programs to SMART Notebook software by using the SMART Notebook Document Writer.</td>
</tr>
<tr>
<td>INSTALL_DOCCAM_DRIVERS</td>
<td>1 (default): Enable the registration of SMART Document Camera drivers. [Empty string]: Disable the registration of SMART Document Camera drivers.</td>
<td>Disable the registration of SMART Document Camera drivers if they conflict with existing third-party drivers on the computer.</td>
</tr>
</tbody>
</table>
## CHAPTER 2

### CUSTOMIZING THE SOFTWARE

<table>
<thead>
<tr>
<th>Property</th>
<th>Allowed values</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENABLE_NB_FIREWALL</td>
<td>1 (default): Allow SMART Notebook software to communicate through the Windows Firewall for advanced NBSDK functionality. 0: Don't allow SMART Notebook software to communicate through the Windows Firewall. SMART Notebook software can listen locally but is unable to communicate through the Windows Firewall.</td>
<td>This property updates the Windows Firewall exception list for Domain and Private networks.</td>
</tr>
<tr>
<td><strong>SMART Product Drivers properties</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENABLE_STPCS</td>
<td>1 (default): Use Tablet PC functionality with the SMART Board interactive whiteboard without connecting a Tablet PC. 0: Don't use Tablet PC functionality with the SMART Board interactive whiteboard without connecting a Tablet PC.</td>
<td>This property is applicable for the Windows 7 operating systems. It has no effect on other operating systems. If you specify 0, users don't have touch support at the Windows logon screen.</td>
</tr>
<tr>
<td>START_SNMP_SERVICE</td>
<td>1: Start Simple Network Management Protocol (SNMP) when the user logs on. 0 (default): Don't start SNMP when the user logs on.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>INSTALL_UNSIGNED_DRIVERS</td>
<td>1: Enable the registration of unsigned third-party drivers. 0 (default): Disable the registration of unsigned third-party drivers.</td>
<td>If you enable the registration of unsigned third-party drivers, the installation process could ask users if they trust the makers of the drivers during installation. This can cause issues if you deploy the installation in Silent mode. Therefore, it's best to disable the registration of third-party drivers if you deploy the installation in Silent mode.</td>
</tr>
<tr>
<td><strong>SMART Ink properties</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOSU_INK</td>
<td>1 (default): Start SMART Ink when the user logs on. 0: Don't start SMART Ink when the user logs on.</td>
<td>[N/A]</td>
</tr>
</tbody>
</table>
### Handwriting recognition resources properties

Don’t select more than 18 handwriting recognition resources if you’re running an administrator installation with the SMARTLearningSuite.msi file (see smarttech.com/kb/170081).

<table>
<thead>
<tr>
<th>Property</th>
<th>Allowed values</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>1: Install the Arabic handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>ZH_CN</td>
<td>1: Install the Chinese (Simplified) handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>ZH_TW</td>
<td>1: Install the Chinese (Traditional) handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>CS</td>
<td>1: Install the Czech handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>DA</td>
<td>1: Install the Danish handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>NL</td>
<td>1: Install the Dutch handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>EN_GB</td>
<td>1: Install the English (UK) handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>ET</td>
<td>1: Install the Estonian handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>FI</td>
<td>1: Install the Finnish handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>FR</td>
<td>1: Install the French handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>DE</td>
<td>1: Install the German handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>EL</td>
<td>1: Install the Greek handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>HE</td>
<td>1: Install the Hebrew handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>HU</td>
<td>1: Install the Hungarian handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>IT</td>
<td>1: Install the Italian handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>JA</td>
<td>1: Install the Japanese handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
</tbody>
</table>
### Property Table

<table>
<thead>
<tr>
<th>Property</th>
<th>Allowed values</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>KO</td>
<td>1: Install the Korean handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>LT</td>
<td>1: Install the Lithuanian handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>LV</td>
<td>1: Install the Latvian handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>MS</td>
<td>1: Install the Malay handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>NB</td>
<td>1: Install the Norwegian handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>PL</td>
<td>1: Install the Polish handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>PT_BR</td>
<td>1: Install the Portuguese (Brazil) handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>RO</td>
<td>1: Install the Romanian handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>RU</td>
<td>1: Install the Russian handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>SK</td>
<td>1: Install the Slovak handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>ES</td>
<td>1: Install the Spanish (Spain) handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>SV</td>
<td>1: Install the Swedish handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>TR</td>
<td>1: Install the Turkish handwriting recognition resource.</td>
<td>[N/A]</td>
</tr>
</tbody>
</table>
## Internet access properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Allowed values</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACC</td>
<td>Integer: Enable Internet access for specified components.</td>
<td>[N/A]</td>
</tr>
<tr>
<td></td>
<td>• 0: No components</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 2: Language Setup</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 4: SMART Product Update</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 8: Customer Experience Program</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 13: All components except Language Setup</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 15 (default): All components</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 3
Deploying the software

Using the command-line interface ................................................................. 26
  Installing prerequisite third-party software ............................................... 26
  Installing SMART software with the complete installer ............................ 27
  Installing SMART software with the installation package ......................... 27
  Examples ...................................................................................................... 28
  Windows Installer parameters ..................................................................... 28
Using third-party imaging or remote management software ............................ 29

You can deploy the software using one of the following methods:

- Deploy the complete installer using the command line interface.
- Deploy the installation packages using the command line interface.
- Deploying the installation packages using third-party imaging or remote management software.

**IMPORTANT**

- Install all the prerequisite third-party installation packages before you deploy the SMARTLearningSuite.msi package. Some SMART Notebook software features will not function as expected if the prerequisite third-party software is not installed first. For more information, see Installing prerequisite third-party software on the next page.

- If you are deploying SMART Product Drivers, the user must log off and log back on after you deploy the software to start the SMART Board Service. In addition, an error message might appear after you deploy the software stating that the SMARTBoardService.exe file could not be found, the user can close this error message. This message will appear only when the system is not connected to a SMART Board interactive flat panel.

- If you want to install handwriting recognition resources, do so when you first deploy the software. If you install a handwriting recognition resource after the first deployment use the resource’s individual MSI file.
NOTES

- You might need to manually activate the software after you deploy it.
- Once the software products are installed, users can use SMART Language Setup to download and install handwriting recognition languages that were not installed by the admin.

Using the command-line interface

Using the command-line interface, you can deploy installation packages in many ways, such as by running commands from the command prompt or by including commands in batch script files.

Installing prerequisite third-party software

To install the Microsoft .NET Framework 4.5.1 files

**NOTE**


Run the following command to install the files in UI mode:

```
[Path]\dotNetFx451_Full_setup.exe /passive /showfinalerror
```

OR

Run the following command to install the files in silent mode:

```
[Path]\dotNetFx451_Full_setup.exe /q
```

Where [Path] is the path to the dotNetFx451_Full_setup.exe file.

To install Microsoft Visual Studio Tools for Office for 32-bit and 64-bit computers

Run the following command:

```
[Path]\vstor_redist.exe /q
```
Where [Path] is the path to the vstor_redist.exe file.

Installing SMART software with the complete installer

Run the following command if you created an XML file to customize the complete installer:

```
"[Path]\SMART Learning Suite.exe" --adminfile [XML file][Parameter]
```

OR

Run the following command if you didn't create an XML file to customize the installation package:

```
"[Path]\SMART Learning Suite.exe" [Properties][Parameter]
```

Where

- [Path] is the path to the SMART Learning Suite.exe file and XML file.
- [XML file] is the name of the XML file.
- [Properties] is a set of properties you can include to customize the installation (see Windows Installer properties on page 16).
- [Parameter] is the installation parameter (see Windows Installer parameters on the next page).

Installing SMART software with the installation package

To install SMART software

Run the following command if you created an MST file to customize the installation package:

```
msiexec /i "[Path]\SMARTLearningSuite.msi" TRANSFORMS="[MST file]" [Parameter]
```

OR

Run the following command if you didn't create an MST file to customize the installation package:

```
msiexec /i "[Path]\SMARTLearningSuite.msi" [Properties][Parameter]
```
CHAPTER 3
DEPLOYING THE SOFTWARE

Where

- [Path] is the path to the SMARTLearningSuite.msi file and MST file.
- [MST file] is the name of the MST file.
- [Properties] is a set of properties you can include to customize the installation (see Windows Installer properties on page 16).
- [Parameter] is the installation parameter (see Windows Installer parameters below).

Examples

The following example installs SMART Notebook software and SMART Product Drivers in Silent mode:

```command
msiexec /i "[Path]\SMARTLearningSuite.msi" INSTALL_NOTEBOOK=1 INSTALL_BOARD=1
INSTALL_INK="" LAT_CONTENT="" FULL_GALLERY=""
```

The following example installs the default software products, SMART Notebook software, SMART Product Drivers, SMART Ink, Gallery Essentials, and Lesson Activity Toolkit:

```command
msiexec /i "[path]\SMARTLearningSuite.msi /q
```

Windows Installer parameters

The following are the standard Windows Installer parameters for the msiexec command.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>/q</td>
<td>Hide the installation wizard.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong>&lt;br&gt;This is Silent mode.</td>
</tr>
<tr>
<td>/qb</td>
<td>Show a basic installation wizard.</td>
</tr>
<tr>
<td>/qb!</td>
<td>Show a basic installation wizard without a Cancel button.</td>
</tr>
<tr>
<td>/qb+!</td>
<td>Show a basic installation wizard without a Cancel button but with a dialog box signaling the end of the installation.</td>
</tr>
<tr>
<td>/qr</td>
<td>Show a reduced installation wizard.</td>
</tr>
<tr>
<td>/qf</td>
<td>Show the full installation wizard, including a dialog box signaling the end of the installation or the Fatal Error, User Exit or Exit dialog box.</td>
</tr>
<tr>
<td>/qn</td>
<td>Hide the installation wizard and the dialog box signaling the end of the installation.</td>
</tr>
</tbody>
</table>
Using third-party imaging or remote management software

The following procedure shows how to deploy SMART software using Group Policy-based deployment software. For information on deploying SMART software using your organization’s third-party imaging or remote management software, see the software’s documentation.

NOTES

- This procedure may vary depending on your version of Windows operating system and your system preferences.
- Ensure your domain controller has Windows Installer 4.5.

To deploy an installation package

1. Copy all contents of the admin .zip file (including subfolders) to `\[Domain Controller]\NETLOGON`, where `[Domain Controller]` is your domain controller.

IMPORTANT

If you want users to be able to view and use the handwriting recognition feature in a language other than English, you must also copy the Support folder to `\[Domain Controller]\NETLOGON`.

The installer looks for handwriting recognition resources in the Support folder only. The Support folder is located in the downloaded .zip file.

Also, for both Gallery and Lesson Activity Toolkit to install and operate successfully, verify that all folders and subfolders of the Support folder is copied over.

It is important you follow these guidelines to ensure a successful installation:

- You must maintain the Support folder structure.
- The Support folder must reside in the root of the folder where the MSI file is stored.

2. Open Control Panel, double-click Administrative Tools, and then double-click Active Directory Users and Computers.

   The Active Directory Users and Computers window appears.

3. Right-click your domain, and then select Properties.

   The Properties dialog box appears.
4. Click the **Group Policy** tab, and then click **Edit**.
   The *Group Policy Object Editor* dialog box appears.

5. Browse to **Computer Configuration\Software Settings**.

6. Right-click **Software Installation**, select **New > Package**, and then browse to and select the MSI file from step 1.

7. In the *Deploy Software* section, click **Advanced**, and then click **OK**.

8. Click the **Modifications** tab, click **Add**, and then browse to and select the MST file from step 1.

9. Click **OK** to apply the MST file to the MSI file.

10. Close all open windows and dialog boxes.
    The next time each computer on the domain starts, the computer automatically installs the software in Silent mode with the customizations defined in the MST file.
Chapter 4
Activating and renewing the software

Activating the software during installation ..............................................................31
Activating the software after installation .............................................................32
Renewing keys ........................................................................................................34
  Renewing keys in unattended mode .................................................................35
  Renewing keys in user interface mode ..............................................................36
  Enabling and disabling automatic renewal of keys ...........................................37
Using SMART Product Update (SPU) to retrieve activation status .....................38
Returning a product key activation with a command-line script ............................39

Activating the software during installation

If you want to activate SMART Notebook software during deployment, you can use either of the following practices, depending on your deployment method:

- **System imaging:** If you use system imaging, do not activate the software before you freeze the image. You can use the Delayed Activation feature to register your product key on the system before freezing it. After the image is deployed, SMART Notebook software will prompt you to activate the registered product key. (see Delay Activation procedure in the table under SMART Install Manager controls on page 12).

- **Network deployment:** If you use a network deployment tool, such as Group Policy software installation, start up scripts, or Microsoft SCCM, you can specify your product key normally in Install Manager or by using command-line parameters. Activation will occur during installation on each individual computer.
Activating the software after installation

There are two situations in which the software doesn’t activate completely:

- **Imaging a computer**: Activation is linked to the hardware identifier of the computer on which the software is installed and activated. If you clone a hard drive image with installed and activated software, you must activate the software on each cloned computer.

- **Reverting a computer to an earlier state**: If you use system recovery or protection software that periodically restores the computer to an earlier state, you might need to activate the software before locking the computer so that the activation record is not cleared each time the computer is restored.

Run the activation wizard while the computer is connected to the network, or complete the following procedure to activate the software on each computer.

---

**NOTE**

SMART Product Drivers and SMART Ink don’t require activation.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>--a</td>
<td>Activate the product key automatically. Specify if it’s an auto renew or not: --no-auto-renew or --auto-renew</td>
</tr>
<tr>
<td>--pks=&quot;[Product keys]&quot;</td>
<td>Specify the product keys. When there are one or more product keys use commas to separate.</td>
</tr>
<tr>
<td>--pk</td>
<td>Specify the product key.</td>
</tr>
<tr>
<td>--v=4</td>
<td>Activation version for this release.</td>
</tr>
<tr>
<td>--puid &lt;Product ID&gt;</td>
<td>Specify the Product ID.</td>
</tr>
<tr>
<td>--monitor=[Number]</td>
<td>Specify the monitor to display the activation wizard.</td>
</tr>
<tr>
<td>--proxy=[Host:Port]</td>
<td>Specify the proxy host and port number to use for activation.</td>
</tr>
<tr>
<td>--proxyuser=[User]</td>
<td>Specify the proxy user name to use for activation.</td>
</tr>
<tr>
<td>--proxypassword=[Password]</td>
<td>Specify the proxy password to use for activation.</td>
</tr>
<tr>
<td>--locale=[Code]</td>
<td>Display the activation wizard user interface in a specific language, where [Code] is your language code (see Installation language files and codes on page 53).</td>
</tr>
</tbody>
</table>
To activate SMART software after installation

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe"
--puid notebook_14 --m=[Value] --v=4 --a [Optional flags] --pks="[Product keys]"
```

Where

- `[Value]` is 4 to run the activation wizard in unattended mode.
- OR
- `[Value]` is 6 to run the activation wizard in user interface mode.
- `[Optional flags]` are options you can include to configure the activation wizard.
- Where `[Product keys]` are one or more software product keys, separated by commas.

To activate only SMART Notebook Math Tools software after installation

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe"
--puid notebook_14 --m=[Value] --v=4 --a [Optional flags]
--pks="[Product keys]"
```

Where

- `[Value]` is 4 to run the activation wizard in unattended mode.
- OR
- `[Value]` is 6 to run the activation wizard in user interface mode.
CHAPTER 4
ACTIVATING AND RENEWING THE SOFTWARE

- [Optional flags] are optional flags you can include to configure the activation wizard.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>--monitor=[Number]</td>
<td>Specify the monitor to display the activation wizard.</td>
</tr>
<tr>
<td>--proxy=[Host:Port]</td>
<td>Specify the proxy host and port number to use for activation.</td>
</tr>
<tr>
<td>--proxyuser=[User]</td>
<td>Specify the proxy user name to use for activation.</td>
</tr>
<tr>
<td>--proxypassword=[Password]</td>
<td>Specify the proxy password to use for activation.</td>
</tr>
<tr>
<td>--locale=[Code]</td>
<td>Display the activation wizard user interface in a specific language, where [Code] is your language code (see Installation language files and codes on page 53).</td>
</tr>
</tbody>
</table>

- Where [Product keys] are one or more software product keys separated by commas.

Renewing keys
If your school has purchased maintenance or subscription licenses, SMART software attempts to renew the keys automatically on a scheduled basis before and after the keys’ expiry dates. However, you can choose to explicitly renew the keys at a specified time. You can also choose to disable automatic renewal in situations where you don’t want the keys on a computer to be renewed (because, for example, you’re planning to retire the computer).

💡 TIP
The activation wizard user interface distinguishes between maintenance and subscription licenses:

- Maintenance licenses are labeled with “Premium features will expire on [Date] without an active subscription”.
- Subscription licenses are labeled with “Expires on [Date]”.

smarttech.com/kb/171152
Renewing keys in unattended mode

To renew all keys

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --m=15 --v=4 --renewal-mode all
```

To renew all keys associated with a single product

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --m=15 --v=4 --renewal-mode product --puid=[Product]
```

Where `[Product]` is `notenook_14`.

**NOTE**

This command renews all keys associated with the specified product.

To renew specific keys

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --m=15 --v=4 --renewal-mode product --puid=[Product] --pks="[Product keys]"
```

Where

- `[Product]` is `notebook_14`.
- Where `[Product keys]` are one or more software product keys separated by commas.
Renewing keys in user interface mode

To renew all keys associated with a single product

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --m=16 --v=4
--renewal-mode product --puid=[Product] --uipack=[UI pack]
```

Where
- `[Product]` is `notebook_14`.
- `[UI pack]` is the corresponding UI pack for the selected product (notebook_10).

**NOTE**

This command renews all keys associated with the specified product.

To renew specific keys

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --m=16 --v=4
--renewal-mode product --puid=[Product] --uipack=[UI pack]
--pks="[Product keys]"
```

Where
- `[Product]` is `notebook_14`.
- `[UI pack]` is the corresponding UI pack for the selected product (notebook_10).
- Where `[Product keys]` are one or more software product keys separated by commas.
Enabling and disabling automatic renewal of keys

To enable automatic renewal of specific keys

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --m=17 --puid=[Product] --v=4 --auto-renew --pks="[Product keys]"
```

Where
- `[Product]` is `notebook_14`.
- `[Product keys]` is the software product key.

To disable automatic renewal of specific keys

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --m=17 --puid=[Product] --v=4 --no-auto-renew --pks="[Product keys]"
```

Where
- `[Product]` is `notebook_14`.
- `[Product keys]` are one or more software product keys separated by commas.

To disable automatic renewal on a computer

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --m=18 --v=4 --no-auto-renew
```

To enable automatic renewal on a computer

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --m=17 --puid=[Product] --v=4 --auto-renew --pks="[Product keys]"
```
Using SMART Product Update (SPU) to retrieve activation status

You can use SMART Product Update (SPU) from the command line to retrieve information on SPU settings and activation status. You could use this in scripts with industry standard execution tools to retrieve information on your network’s computers.

To use SPU on 32-bit Windows

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --query [Options] > OutputFile.txt 2>nul
```

**NOTES**

- OutputFile.txt is the file in which you record the results. The path to this file can be absolute or relative. When specifying a path to a folder, make sure you have write permissions to that folder.
- The 2>nul command suppresses any messages that appear on the Standard Error output stream.
- [Options] is used for the following optional parameters:
  - --format [Format]
    - Valid values for [Format] are csv, json or xml. The json and xml format provides full details, and csv formats provide basic information.
  - --key [Key]
    - This parameter is used to narrow down the returned results. The appropriate format for this parameter is json or xml.
  - The 64-bit version of this command uses the same options and parameters as the 32-bit version.
To use SPU on 64-bit Windows

Run the following command:

```
"C:\Program Files (x86)\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --query [OPTIONS] > OutputFile.txt 2>nul
```

Returning a product key activation with a command-line script

As of version 17.0, SMART Notebook supports the return of a product key activation with a command-line script. An `activationwizard.exe` command can be deployed across the network to return the activation from several computers, making the product key available for use on other computers.

You can specify multiple keys in one command by using the command format below.

To return product keys on 32-bit Windows

Run the following command:

```
"C:\Program Files\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --puid notebook_14 --m=4 --v=4 --return --pks=[Product key],[Product key]
```

To return product keys on 64-bit Windows

Run the following command:

```
"C:\Program Files (x86)\Common Files\SMART Technologies\SMART Product Update\activationwizard.exe" --puid notebook_14 --m=4 --v=4 --return --pks=[Product key],[Product key]
```
Chapter 5

Updating the software

Using a Windows Installer update installation package (MSI file) .................................................. 42
Using a Windows Installer patch (MSP file) ................................................................. 43

SMART periodically releases updates to its software. These updates add new features and resolve issues.

Go to smarttech.com/software to download the latest installation package. SMART provides updates in two file formats in the installation package:

- Windows Installer update installation packages (MSI files)
- Windows Installer patches (MSP files)

**NOTE**

MSP files are available only for select updates as identified on the SMART website.

Which file format you use depends on the version of the software installed on your computers and the version of the update. If these versions are the same, you can use the MSP file, if available, to install the update. If these versions are different (because, for example, a previous version of the software is installed on your computers), you must first upgrade the software on your computers to the same version as the update using the MSI file and then install the update using the MSP file, if available.

After you download an installation package and extract the update files, place the update files in a location on your network that’s accessible to all the computers you plan to update.

**IMPORTANT**

You cannot roll back an update after installing it on your computers. You must uninstall the full version of the software using Control Panel or the command line interface (see Chapter 6: Uninstalling the software on page 45), and then install the previous version of the software.
Using a Windows Installer update installation package (MSI file)
The command line for running an update using a Windows Installer update installation package varies depending on whether the update is major or minor.

**NOTE**
The SMART website indicates whether an update is major or minor.

To run a major software update using a Windows Installer update installation package
Run the following command:

```
msiexec /i "[Path]\[File].msi" [Parameter]
```

Where
- `[Path]` is the path to the MSI file.
- `[File]` is the name of the MSI file.
- `[Parameter]` is the installation parameter (see Windows Installer parameters on page 28).

**IMPORTANT**
Do not include the REINSTALLMODE and REINSTALL properties.

To run a minor software update using a Windows Installer update installation package
Run the following command:

```
msiexec /i "[Path]\[File].msi" REINSTALLMODE=vomus REINSTALL=ALL [Parameter]
```

Where
- `[Path]` is the path to the MSI file.
- `[File]` is the name of the MSI file.
- `[Parameter]` is the installation parameter (see Windows Installer parameters on page 28).
You must include the REINSTALLMODE=vomus and REINSTALL=ALL properties for a minor update to succeed.

Using a Windows Installer patch (MSP file)

To run a software update using a Windows Installer patch

Run one of the following commands:

```
msiexec /p "[Path]\[File].msp" REINSTALLMODE=vomus /q
```

```
msiexec /update "[Path]\[File].msp" /quiet
```

Where

- `[Path]` is the path to the MSP file.
- `[File]` is the name of the MSP file.
Chapter 6

Uninstalling the software

Using the SMART Uninstaller user interface ................................................................. 45
Using the SMART Uninstaller command line interface ............................................. 46
   Other commands ........................................................................................................ 49
   Product codes ........................................................................................................... 49

After installing SMART Learning Suite 17, you can use SMART Uninstaller to uninstall the software.

Using the SMART Uninstaller user interface

You can uninstall SMART Learning Suite 17 from individual computers using the SMART Uninstaller user interface.

To uninstall SMART Learning Suite 17 using the SMART Uninstaller user interface

1. In Windows 7 operating system, select Start > All Programs > SMART Technologies > SMART Tools > SMART Uninstaller.
   OR
   In Windows 8.1 operating system, go to the Apps screen and then scroll to and select SMART Technologies > SMART Uninstaller.
   OR
   In Windows 10 operating system, select Start > All apps, and then scroll to and select SMART Technologies > SMART Uninstaller.
2. Press Next.
3. Select the check boxes of the SMART software and supporting packages that you want to uninstall, and then press **Next**.

**NOTES**
- Some SMART software is dependent on other SMART software. If you select this software, SMART Uninstaller automatically selects the software on which it depends.
- SMART Uninstaller automatically uninstalls any supporting packages that are no longer being used.
- If you choose to uninstall all SMART software, SMART Uninstaller automatically uninstalls all supporting packages, including itself.

**TIPS**
- To select all software and supporting packages, press **Select All**.
- To clear the selection of all software and supporting packages, press **Clear All**.

4. Press **Uninstall**.

SMART Uninstaller uninstalls the selected software and supporting packages.

5. Press **Finish**.

**Using the SMART Uninstaller command line interface**

In addition to the user interface, SMART Uninstaller provides a command-line interface. You can use this interface to automate the removal of SMART Learning Suite 17 and uninstall SMART Learning Suite 17 remotely.

**NOTE**

SMART recommends that you copy SMART Uninstaller to a temporary location before running command lines and prefix command lines with **start /wait**.
CHAPTER 6
UNINSTALLING THE SOFTWARE

To uninstall all SMART software

1. Copy SMART Uninstaller to a temporary location by running one of the following commands:
   - For 32-bit operating systems:
     
     copy "%CommonProgramFiles%\SMART Technologies\SMART Uninstaller.exe" "%TEMP%"
   - For 64-bit operating systems:
     
     copy "%CommonProgramFiles(x86)%\SMART Technologies\SMART Uninstaller.exe" "%TEMP%"

2. Uninstall all software by running the following command:

   start /wait "SMART Uninstaller" "%TEMP\SMART Uninstaller.exe" --noui
   --uninstall-all --uilevel none

3. Delete the copy of SMART Uninstaller in the temporary location by running the following command:

   del "%TEMP\SMART Uninstaller.exe"

To uninstall SMART software by product name

1. Copy SMART Uninstaller to a temporary location by running one of the following commands:
   - For 32-bit operating systems:
     
     copy "%CommonProgramFiles%\SMART Technologies\SMART Uninstaller.exe" "%TEMP%"
   - For 64-bit operating systems:
     
     copy "%CommonProgramFiles(x86)%\SMART Technologies\SMART Uninstaller.exe" "%TEMP%"
CHAPTER 6
UNINSTALLING THE SOFTWARE

2. Uninstall select software by running the following command:

```
start /wait "SMART Uninstaller" "%TEMP%\SMART Uninstaller.exe" --noui --uninstall "[Product names]" --uilevel none
```

Where [Product names] is a comma delimited list of product names.

3. Delete the copy of SMART Uninstaller in the temporary location by running the following command:

```
del "%TEMP%\SMART Uninstaller.exe"
```

To uninstall SMART software by product code

1. Copy SMART Uninstaller to a temporary location by running one of the following commands:
   - For 32-bit operating systems:
     ```
copy "%CommonProgramFiles%\SMART Technologies\SMART Uninstaller.exe" "%TEMP%"
```
   - For 64-bit operating systems:
     ```
copy "%CommonProgramFiles(x86)%\SMART Technologies\SMART Uninstaller.exe" "%TEMP%"
```

2. Uninstall select software by running the following command:

```
start /wait "SMART Uninstaller" "%TEMP%\SMART Uninstaller.exe" --noui --uninstall-pc [Product codes] --uilevel none
```

Where [Product codes] is a comma delimited list of product codes.

3. Delete the copy of SMART Uninstaller in the temporary location by running the following command:

```
del "%TEMP%\SMART Uninstaller.exe"
```
Other commands

The following is a list of all the commands you can use with SMART Uninstaller.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>--dry-run</td>
<td>Runs the command line but doesn’t uninstall the software.</td>
<td>This is useful for testing command lines before running them.</td>
</tr>
<tr>
<td>--locale [Language code]</td>
<td>Displays SMART Uninstaller in a language other than the operating system’s language.</td>
<td>The appropriate language pack must be installed to display SMART Uninstaller in the language.</td>
</tr>
<tr>
<td>--uilevel [Level]</td>
<td>Specifies the user interface that displays when SMART Uninstaller uninstalls the software.</td>
<td>Normally, --uilevel none is used only in combination with --noui.</td>
</tr>
<tr>
<td>--no-auto-remove</td>
<td>Disables the automatic removal of supporting packages (for example, SMART Common Files) that are no longer required after the selected packages are uninstalled.</td>
<td>This is used only if --noui is also included.</td>
</tr>
<tr>
<td>--noui</td>
<td>Doesn’t display the SMART Uninstaller user interface.</td>
<td>Normally, --noui is used only in combination with --uilevel none.</td>
</tr>
<tr>
<td>--uninstall-all</td>
<td>Uninstalls all detected SMART packages.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>--uninstall [Product names]</td>
<td>Uninstalls the specified products.</td>
<td>[N/A]</td>
</tr>
<tr>
<td>--uninstall-pc [Product codes]</td>
<td>Uninstalls the specified products.</td>
<td>[N/A]</td>
</tr>
</tbody>
</table>

Product codes

<table>
<thead>
<tr>
<th>Version</th>
<th>Product code</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART Notebook software</td>
<td></td>
</tr>
<tr>
<td>11.4</td>
<td>{79660EE7-9C0B-4962-B566-2693FE34719D}</td>
</tr>
</tbody>
</table>
### Chapter 6
UNINSTALLING THE SOFTWARE

<table>
<thead>
<tr>
<th>Version</th>
<th>Product code</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.0</td>
<td>{4DF72C85-33C5-4297-A0DE-FC6DB766695D}</td>
</tr>
<tr>
<td>14.1</td>
<td>{84579080-E961-4DE7-93AB-5E2B81A96387}</td>
</tr>
<tr>
<td>14.2</td>
<td>{D4C0DEF0-8D83-4884-91D9-83A07D0F2CB5}</td>
</tr>
<tr>
<td>14.3</td>
<td>{18E53BBD-971F-4A77-9620-EB2C1539E308}</td>
</tr>
<tr>
<td>15.0</td>
<td>{955F23AC-CABC-4F34-A3E4-3DF23056B48E}</td>
</tr>
<tr>
<td>15.1</td>
<td>{5E112563-E291-4C20-849F-49CE3BAD73D1}</td>
</tr>
<tr>
<td>15.2</td>
<td>{E6EE86DD-5B8B-483D-83EB-18B9E1FD9BB8}</td>
</tr>
<tr>
<td>16.0</td>
<td>{47F91537-12BD-4B30-8726-5A033FE61CDA}</td>
</tr>
<tr>
<td>16.1</td>
<td>{AA217CD3-F8C1-4AEA-A145-5850078BF8B7}</td>
</tr>
<tr>
<td>16.2</td>
<td>{87948734-3F7C-4E9D-8702-3B05AF3CDA23}</td>
</tr>
<tr>
<td>17.0</td>
<td>{6C0DF5B1-412D-4F0D-8DED-3B563A20B033}</td>
</tr>
<tr>
<td>17.0.1</td>
<td>{5EBEDBC2-0986-4311-8C52-52C5C69E8102}</td>
</tr>
</tbody>
</table>

**SMART Product Drivers**

<table>
<thead>
<tr>
<th>Version</th>
<th>Product code</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.4</td>
<td>{53330A17-78DE-458E-9997-292A2D6D3ADD}</td>
</tr>
<tr>
<td>11.5</td>
<td>{B1209081-5D82-4F8A-8318-BE7583B6E265}</td>
</tr>
<tr>
<td>11.6</td>
<td>{890680EC-2F88-47F0-970C-593081E62593}</td>
</tr>
<tr>
<td>12</td>
<td>{111A1715-267A-4387-B63D-D7E6E7D97677}</td>
</tr>
<tr>
<td>12.1</td>
<td>{67F35E75-A186-4F80-B291-8283331D5550}</td>
</tr>
<tr>
<td>12.2</td>
<td>{C3C9E674-3FD2-4535-B733-C7C62074DC4A}</td>
</tr>
<tr>
<td>12.3</td>
<td>{A418B556-1E81-4D42-B54E-979720B3DEBF}</td>
</tr>
<tr>
<td>12.4</td>
<td>{BFF16FAE-1B84-40EA-B60E-385F5A925212}</td>
</tr>
<tr>
<td>12.5</td>
<td>{696243E7-E4BB-4696-ACF0-C6D2FC012136}</td>
</tr>
<tr>
<td>12.6</td>
<td>{1E280E41-ED8E-424C-9EA9-FD52963B21BE} (shipped with SMART Notebook 16.1)</td>
</tr>
<tr>
<td></td>
<td>{3298B999-38D0-4650-8FB7-3C9E71325465} (shipped with SMART Notebook 16.2)</td>
</tr>
<tr>
<td>12.7</td>
<td>{1E280E41-ED8E-424C-9EA9-FD52963B21BE}</td>
</tr>
<tr>
<td>12.8</td>
<td>{A292B5F2-F55A-4960-A58F-07569554D321}</td>
</tr>
</tbody>
</table>
## Uninstalling the Software

<table>
<thead>
<tr>
<th>Version</th>
<th>Product code</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART Ink</td>
<td></td>
</tr>
<tr>
<td>2.0</td>
<td>5ABC49B5-D0DC-428D-A082-4AEFF6490F04</td>
</tr>
<tr>
<td>2.1</td>
<td>B4F5D378-9784-442B-97D5-24CAAF3299AA</td>
</tr>
<tr>
<td>2.2</td>
<td>FC69B741-DC56-4591-97A2-A6BA21B7E76</td>
</tr>
<tr>
<td>2.3</td>
<td>FAF3CC40-F647-4AA7-84D6-7BD67C4F2362</td>
</tr>
<tr>
<td>2.3.1</td>
<td>232C8EC0-4856-4EEA-B99F-5FCC4E103A09</td>
</tr>
<tr>
<td>3.1</td>
<td>52ECF84B-09E9-4C98-B4FD-17EE1BC09921</td>
</tr>
<tr>
<td>3.2</td>
<td>57E67FAF-87D9-4573-BC7F-C95B1A71287A</td>
</tr>
<tr>
<td>4.0</td>
<td>A5AEF478-1170-4335-86B8-561328B193EC</td>
</tr>
<tr>
<td>4.1</td>
<td>7AB1FDF1-6998-43AD-B705-EA8AF7439407</td>
</tr>
<tr>
<td>4.2</td>
<td>11ECCC34-FC75-4DA0-B13D-E89D1E6661BF</td>
</tr>
<tr>
<td>5.0</td>
<td>89E25BCE-F949-405E-ADA9-8537B4F4E2B8</td>
</tr>
<tr>
<td>5.1</td>
<td>A292B5F2-F55A-4960-A58F-07569554D321</td>
</tr>
<tr>
<td>SMART Common Files</td>
<td></td>
</tr>
<tr>
<td>2013 (11.3)</td>
<td>BBA07B40-F7C6-44F7-BF08-767F8835685F</td>
</tr>
<tr>
<td>2013 (11.4)</td>
<td>26A95DBF-A866-4838-A8C9-FA219FCBD22E</td>
</tr>
</tbody>
</table>
## Appendix A

### Language files and codes

Installation language files and codes ............................................. 53
Handwriting recognition resources ................................................. 54

### Installation language files and codes

<table>
<thead>
<tr>
<th>Language</th>
<th>Code</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>English (U.S.)</td>
<td>1033</td>
<td>1033.mst</td>
</tr>
<tr>
<td>English (UK)</td>
<td>2057</td>
<td>2057.mst</td>
</tr>
<tr>
<td>Arabic</td>
<td>1025</td>
<td>1025.mst</td>
</tr>
<tr>
<td>Chinese (Simplified)</td>
<td>2052</td>
<td>2052.mst</td>
</tr>
<tr>
<td>Chinese (Traditional)</td>
<td>1028</td>
<td>1028.mst</td>
</tr>
<tr>
<td>Czech</td>
<td>1029</td>
<td>1029.mst</td>
</tr>
<tr>
<td>Danish</td>
<td>1030</td>
<td>1030.mst</td>
</tr>
<tr>
<td>Dutch</td>
<td>1043</td>
<td>1043.mst</td>
</tr>
<tr>
<td>Estonian</td>
<td>1061</td>
<td>1061.mst</td>
</tr>
<tr>
<td>Finnish</td>
<td>1035</td>
<td>1035.mst</td>
</tr>
<tr>
<td>French (France)</td>
<td>1036</td>
<td>1036.mst</td>
</tr>
<tr>
<td>German</td>
<td>1031</td>
<td>1031.mst</td>
</tr>
<tr>
<td>Greek</td>
<td>1032</td>
<td>1032.mst</td>
</tr>
<tr>
<td>Hebrew</td>
<td>1037</td>
<td>1037.mst</td>
</tr>
<tr>
<td>Hungarian</td>
<td>1038</td>
<td>1038.mst</td>
</tr>
<tr>
<td>Italian</td>
<td>1040</td>
<td>1040.mst</td>
</tr>
<tr>
<td>Japanese</td>
<td>1041</td>
<td>1041.mst</td>
</tr>
<tr>
<td>Latvian</td>
<td>1062</td>
<td>1062.mst</td>
</tr>
<tr>
<td>Language</td>
<td>Code</td>
<td>File</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td>Lithuanian</td>
<td>1063</td>
<td>1063.mst</td>
</tr>
<tr>
<td>Norwegian</td>
<td>1044</td>
<td>1044.mst</td>
</tr>
<tr>
<td>Polish</td>
<td>1045</td>
<td>1045.mst</td>
</tr>
<tr>
<td>Portuguese (Brazil)</td>
<td>1046</td>
<td>1046.mst</td>
</tr>
<tr>
<td>Romanian</td>
<td>1048</td>
<td>1048.mst</td>
</tr>
<tr>
<td>Russian</td>
<td>1049</td>
<td>1049.mst</td>
</tr>
<tr>
<td>Spanish (Spain)</td>
<td>1034</td>
<td>1034.mst</td>
</tr>
<tr>
<td>Slovak</td>
<td>1051</td>
<td>1051.mst</td>
</tr>
<tr>
<td>Swedish</td>
<td>1053</td>
<td>1053.mst</td>
</tr>
<tr>
<td>Turkish</td>
<td>1055</td>
<td>1055.mst</td>
</tr>
</tbody>
</table>

Handwriting recognition resources

The SMART Learning Suite 16 and later language packs contain handwriting recognition resources only. Additional localization resources previously contained in language packs are included in the product installation files.

<table>
<thead>
<tr>
<th>File</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>arabic_handwriting.msi</td>
<td>(648C7144-1B6F-497B-9F1A-6DFAE8773816E)</td>
</tr>
<tr>
<td>chinese_(simplified)_handwriting.msi</td>
<td>(CA05B824-9AA6-455B-8DF5-2453C865FAF3)</td>
</tr>
<tr>
<td>chinese_(traditional)_handwriting.msi</td>
<td>(74B9E115-5E23-4928-92E3-73B8631AA524)</td>
</tr>
<tr>
<td>czech_handwriting.msi</td>
<td>(65A75580-36A0-4490-8181-0967DD6C1464)</td>
</tr>
<tr>
<td>danish_handwriting.msi</td>
<td>(621893D0-3F77-4768-8C43-CD3FA168914)</td>
</tr>
<tr>
<td>dutch_handwriting.msi</td>
<td>(B4D49CAE-EF29-4775-B0BA-0DFD6B2D69D9)</td>
</tr>
<tr>
<td>english_(united_kingdom)_handwriting.msi</td>
<td>(B5D509DC-3361-43D7-ADED-916CC6E90A03)</td>
</tr>
<tr>
<td>estonian_handwriting.msi</td>
<td>(87C03A3D-8B0B-424D-AE43-4ECD74C3CC8E)</td>
</tr>
<tr>
<td>finnish_handwriting.msi</td>
<td>(D2BFFB26-00CD-4CA3-932F-818A5C8C7CD8)</td>
</tr>
<tr>
<td>french_handwriting.msi</td>
<td>(EF73F08B-7E56-4D36-9FA-68F358F52732)</td>
</tr>
<tr>
<td>german_handwriting.msi</td>
<td>(2B73B447-A3E4-437F-9E7F-AE53A93D4A2)</td>
</tr>
<tr>
<td>greek_handwriting.msi</td>
<td>(5066774D-FF40-45EA-B779-F7F36DBC70B7)</td>
</tr>
<tr>
<td>hebrew_handwriting.msi</td>
<td>(3623E3DE-104A-4651-B8E3-9D2B51636A2F)</td>
</tr>
<tr>
<td>File</td>
<td>Code</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>hungarian_handwriting.msi</td>
<td>(3AE061AF-B255-4052-9918-849AD4FE0C56)</td>
</tr>
<tr>
<td>italian_handwriting.msi</td>
<td>(AF09A64A-245A-458A-8290-421D611A21F5)</td>
</tr>
<tr>
<td>japanese_handwriting.msi</td>
<td>(3FB8FA79-CAF4-47CD-A599-D68F72D1CAD1)</td>
</tr>
<tr>
<td>korean_handwriting.msi</td>
<td>(C106402C-BC3E-4EA4-A3AE-6DBBCB785DC3)</td>
</tr>
<tr>
<td>latvian_handwriting.msi</td>
<td>(0E88A795-CCF7-46CD-9E8A-1739A539A382)</td>
</tr>
<tr>
<td>lithuanian_handwriting.msi</td>
<td>(EE96CAF4-2439-4CD9-BFF7-DC3DFBC7781B)</td>
</tr>
<tr>
<td>malay_handwriting.msi</td>
<td>(33A07CFE-B356-45A7-B2E5-99F536CC84B9)</td>
</tr>
<tr>
<td>norwegian_handwriting.msi</td>
<td>(AE4A8476-F602-4FC0-A40D-336DC76DD7EE)</td>
</tr>
<tr>
<td>polish_handwriting.msi</td>
<td>(11725848-4E79-874C-E59D1DA6A122)</td>
</tr>
<tr>
<td>portuguese_(brazil)_handwriting.msi</td>
<td>(3C2062D0-82F6-4CE3-ADAD-F993CBE2F4F5)</td>
</tr>
<tr>
<td>romanian_handwriting.msi</td>
<td>(84BCEABF-4624-447D-89D8-5D0B5F4DFFBC)</td>
</tr>
<tr>
<td>russian_handwriting.msi</td>
<td>(4CF5A60A-8E02-4376-A9F5-8C343D473FCD)</td>
</tr>
<tr>
<td>slovak_handwriting.msi</td>
<td>(5E6F10F3-9006-4F78-B231-18866B792E06)</td>
</tr>
<tr>
<td>spanish_handwriting.msi</td>
<td>(62F6F0A3-8B04-4FDF-ABB4-11F3A042EB8A)</td>
</tr>
<tr>
<td>swedish_handwriting.msi</td>
<td>(9B9B50A8-84A4-4547-A9E5-FA3868CDF78B)</td>
</tr>
<tr>
<td>turkish_handwriting.msi</td>
<td>(9D3E3459-395A-4514-8C67-064C123C77C4)</td>
</tr>
</tbody>
</table>
Appendix B

Installing and maintaining Gallery content

Gallery content includes the following:

- Gallery Essentials, which is a collection of educational photos, images, and audio files compatible files.
- Lesson Activity Toolkit, which contains objects teachers can use to create their own lesson activities.

You can access Gallery content from the Gallery tab in SMART Notebook software.

Configuring Gallery content using SMART Install Manager

If you’re customizing the software using SMART Install Manager, complete the procedure in this section to configure Gallery content.

To configure Gallery content using SMART Install Manager

1. Open the software installation package in SMART Install Manager.
2. Click Product Selection.
   The Product Selection page appears.
3. Select SMART Notebook (and any other products you want to install).
4. Click Gallery Content.
   The Gallery Content page appears.
5. Select the Gallery content to be installed on each computer.
   Gallery Essentials
   Lesson Activity Toolkit
6. Publish your changes, and then deploy the files.
   If you loaded the ESI .EXE with Install Manager, publish will produce a .xml file.
   If you loaded the ESI .MSI with Install Manager, publish will produce a .mst file.
7. Make sure the .xml or .mst file is saved into the same folder as the ESI installation package to be deployed.

**Working with Gallery content locations**

After installing the software, you can do the following:

- Starting the software in Administration mode.
- Change the location of the My Content folder.
- Create or connect to a Team Content folder.
- Connect to an RSS feed.

**Starting the software in Administration mode**

Before you can maintain content folders, you must start the software in Administration mode.

**To start SMART Notebook software in Administration mode**

1. Open a Command Prompt window.
2. Type the following command:

   ```
   "[Path]\Notebook.exe" /admin
   ```

   Where [Path] is the path to the SMART Notebook software program folder.
3. Press ENTER.

   SMART Notebook software starts in Administration mode.

**Changing the location of the My Content folder**

The **My Content** folder is a location where teachers and students can store content for their individual use.

You can specify the location of the My Content folder during installation or afterward.
To create a new Team Content folder

1. Start the software in Administration mode.
2. Click the Gallery tab.
3. Click the Click here for more Gallery options icon, and then select Administration: Content Locations.
   The Administration: Content Locations dialog box appears.
4. Click Browse.
   The Browse For Folder dialog box appears.
5. Browse to and select the new My Content folder, and then click OK.
6. Click Close.
7. Close the software.

Creating or connecting to Team Content folders
All users can create new content and save it in their My Content folders. To allow users to share content, you must create or connect to a Team Content folder.

TIP
If you create a Team Content folder on a computer’s hard disk, the folder is available only to users of that computer. However, if you create a Team Content folder on a server, the folder is available to all users on the school’s network with read and write access to the folder.

To create a new Team Content folder

1. Start the software in Administration mode.
2. Click the Gallery tab.
3. Click the Click here for more Gallery options icon, and then select Administration: Content Locations.
   The Administration: Content Locations dialog box appears.
4. Click Connect to Team Content.
5. Browse to and select the folder you want to designate as a Team Content folder, and then click OK.

**NOTE**

The software adds an imsmanifest.xml file to the Team Content folder after you click OK. This file identifies the folder as a Team Content folder.

6. Click Close.

7. Close the software.

**To connect to an existing Team Content folder**

1. Start the software in Administration mode.
2. Click the Gallery tab.
3. Click the Click here for more Gallery options icon, and select Administration: Content Location.

   The Administration: Content Location dialog box appears.

4. Click Add Existing.

**NOTE**

The Team Content folder should appear in the list of content folders under the Gallery tab.

5. Browse to and select the Team Content folder, and then click OK.

6. Click Close.

7. Close the software.

**To disconnect a Team Content folder**

1. Start the software in Administration mode.
2. Click the Gallery tab.
3. Click the Click here for more Gallery option icon, and then select Administration: Content Locations.

   The Administration: Content Locations dialog box appears.
4. Select the folder in the Team Content list, and then click Remove.

**IMPORTANT**

If you installed the Gallery Essentials and Lesson Activity Toolkit collections, folders for those collections appear in the Team Content list. Do not remove these folders from the list, or users will not be able to access these collections.

5. Click Close.

6. Close the software.

Connecting to and RSS feed

You can connect to a public or private RSS feed to send information to your school’s SMART Notebook software and SMART Notebook SE users through the Gallery tab.

RSS is a format for delivering regularly changing web content. Many news-related websites, blogs and other publishers broadcast their content as RSS feeds.

To connect to an RSS feed

1. Start the software in Administration mode.
2. Click the Gallery tab.
3. Click the Click here for more Gallery options icon, and then select Administration: Content Locations.
   
   The Administration: Content Locations dialog box appears.
4. Type the URL of the RSS feed in the Online Resources box.
5. Click Close.
6. Close the software.